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WELCOME!

Apple provides a professional set of development tools for free. You should use them!

Since our Muon g-2 code builds on a
Mac, you can use your Mac laptop or
desktop for development. Apple pro-
vides a professional set of tools, Xcode
and Instruments, for your code develop-
ment use.

Note: It is important to remember that
running code on your Mac is still consid-
ered experimental. All long runs and
code producing official results should
run on the Grid under Linux.

For general information about Muon g-2
code and development, you should see
the manual at GM2-db-1825 or the
gm2swtools product in the release.

There are several benefits that Xcode
and Instruments give you over coding
with text editors like Emacs and vi,

« Xcode is a very convenient code editor
with advanced navigating and editing
capabilities

e You can click on a #include directive
and jump to the header file

 You can click on a class or object
name and jump to its definition.

« Xcode understands projects: you can
view all of the source code that goes
together to make a build

- Easily search (and replace) text in a
file or the entire project

« Code build errors are displayed in the
source code at the problematic line

« Debugging with an IDE (not in the ter-
minal)

« Built in git management and version
comparisons

- Easily profile your code for speed,
memory allocation, and memory leaks

Xcode is a very capable integrated de-
velopment environment (IDE) and we'll
scratch the surface here.

Note that while we are developing on
the Mac, we are not using the Apple
compiler nor Apple’s framework environ-
ment. Limitations will result.


http://gm2-docdb.fnal.gov/cgi-bin/ShowDocument?docid=1825
http://gm2-docdb.fnal.gov/cgi-bin/ShowDocument?docid=1825

RESOURCES FOR LEARNING MORE

The WWDC videos are useful to learn Xcode and Instruments

Xcode comes with extensive documenta-
tion. Some go very deep and some are
very terse. | have found that several Ap-
ple WWDC (World-Wide Developer’s
Conference) videos give a lot of good in-
formation.

To view the videos, you will need to use
Safari and you will need an Apple Devel-
oper’s account (it's free). Here is a list of
videos that | have found useful.

Many of the videos talk about Mac spe-
cific functions that we do not use, but
there’s enough general information to
make them useful.

Xcode is a big complicated program!
Have fun trying stuff and learning it.

WWDC 2012 (link):

« Working Efficiently with Xcode. Nice explanations of various ways of using the pro-
gram (single window, single window with tabs, multiple windows)

« Debugqging in Xcode. Useful demonstration of the Xcode debugger

« Advanced Debugging with LLDB. Advanced tips for using the Apple debugger
(mostly works with our code)

« Learning Instruments. A somewhat useful tour of Instruments
WWDC 2013 (link):

« Core Xcode. Lots of useful tips for using Xcode, including a section on Xcode funda-
mentals

WWDC 2014 (link):

« Improving your App with Instruments. A good tour of Instruments


https://developer.apple.com/videos/wwdc/2012/
https://developer.apple.com/videos/wwdc/2012/
https://developer.apple.com/videos/wwdc/2013/
https://developer.apple.com/videos/wwdc/2013/
https://developer.apple.com/videos/wwdc/2014/
https://developer.apple.com/videos/wwdc/2014/

Setting up your Mac

o Installing CVMFES

o Installing Xcode



1.1 HOW TO INSTALL CVMFS

CVMFS makes distributing executables and libraries very easy.

We distribute our executables and librar-
ies via the CERN Virtual File System
(CVMES). It allows you to “subscribe” to
published directories. You will get up-
dates automatically as they are pushed

out from Fermilab. We use the Open Sci-

ence Grid OASIS CVMEFS service, sup-
plying CVMFS for several experiments.
You may learn more about CVMFS on
the web.

If you have CVMFS already. Check if
CVMES is running with,

ps -ef | grep cvmfs | grep -v grep

If you get no response, then you are not
running CVMFS. If you do get a re-
sponse, then reboot your Mac now to
start without CVMFS running.

If you have a /cvmfs directory (you've
installed CVMFS before), then you
should clear your CVMFS cache with,

sudo cvmfs _config wipecache

and remove all of the mount points with,

sudo rm -rf /cvmfs/* # Careful!

You may now re-install CVMFS.

Installing CVMFS. Go to

http://cernvm.cern.ch/portal/filesystem/downloads

to download the Mac OSX client of
CVMEFS. Install it and follow any instruc-
tions that it gives, including installing
FUSE. Be sure to install a late version of
FUSE (the page that CVMFS may send

you to might be old - the correct page is
https://osxfuse.qgithub.io/).

Once the installation is complete, You
create the configuration files by doing,

sudo cvmfs _config setup

Install mount point. You must now in-
stall the mount point with,

mkdir -p /cvmfs/oasis.opensciencegrid.org

Download configuration files. Down-
load the configuration files from here
(you should get a file called
cvmfs_mac_config 20140114.tgz). Put
it in the right place and then do


http://cernvm.cern.ch/portal/filesystem
http://cernvm.cern.ch/portal/filesystem
http://cernvm.cern.ch/portal/filesystem/downloads
http://cernvm.cern.ch/portal/filesystem/downloads
https://osxfuse.github.io
https://osxfuse.github.io
https://cdcvs.fnal.gov/redmine/attachments/download/14981/cvmfs_mac_config_20140114.tgz
https://cdcvs.fnal.gov/redmine/attachments/download/14981/cvmfs_mac_config_20140114.tgz

cd /etc/cvmfs
sudo tar xvzf /<YourDownloadPath>/cvmfs mac config 20140114.tgz
sudo cvmfs config reload

Mount CVMFS. To start CVMFS, issue this command now and whenever you reboot your machine, (you may
want to put this in a script)

sudo mount -t cvmfs oasis.opensciencegrid.org /cvmfs/oasis.opensciencegrid.org

Stopping and restarting CVMS. You can stop CVMFS with this command,

sudo umount -f /cvmfs/oasis.opensciencegrid.org

To restart, issue the mount command above.

Problems. You may find that after changing networks or having the computer sleep for a period of time you will
get intermittent problems reading files in CVMFS (e.g. i/o errors). If this happens, simply restart CVMFS with
(combination of the lines above),

sudo umount -f /cvmfs/oasis.opensciencegrid.org

sudo mount -t cvmfs oasis.opensciencegrid.org /cvmfs/oasis.opensciencegrid.org



1.2 HOW TO INSTALL XCODE

Xcode 1S freely available from the App Store.

Get Xcode from the Mac App store. It is
free. Open the App Store (Apple Menu >
App Store) and search for Xcode. It is a
big file (nearly 2.5 GB), so it will take a
long time to download and install. You
should install it to your machine’s main
Applications folder. Xcode was at ver-
sion 6.1.1 at the time this document was
written.

Once Xcode has installed, you must
check for the command line tools. Do,

1s /usr/include

You should see nearly 250 files. If you
see none or very few, then do from a ter-
minal,

xcode-select --install

Issuing that command will download and
install the command line tools and will
populate that and other directories with
the correct files.

You are now ready to code with Xcode.

The Instruments profiling tool is down-
loaded and installed with Xcode auto-
matically.
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2.1 WHAT ARE XCODE AND INSTRUMENTS?

Xcode 1s an Integrated Development Environment (IDE), a software application
providing comprehensive support for software development including source code
editing, code building, and debugging. Instruments is an application for profiling
software’s use of resources.

Apple writes many application programs well as Linux. Examples include Eclipse,
for their Mac computers as well as iOS NetBeans, and IntelliJ Idea. All of these
devices (iPhone & IPad). They have focus on Java development, but have
made some of their development tools features that work with C++. A new IDE
available for general use. While our soft- called CLion is meant for C++ work,
ware takes no advantage of the special but is in an Early Access Build pro-
capabilities and libraries on the Mac and gram. Despite all of these options, |
does not run on iOS, we can neverthe- have focused on Xcode as it seems, to
less take advantage of the nice software me, to be the easiest to start using
development tools. Some of the fea- (only if you have a Mac, of course).

tures Xcode offers were detailed in the
Welcome section of this document. You
may find other information at the Xcode
webpage, but note that most of the mar-
keting materials focus on writing Mac/
IOS applications.

Instruments is an application that can
profile your program and show a time-
line of resource usages, including CPU
time, memory, i/o, etc. It is easy to use
and gives a huge amount information
that may not be easy to interpret. Some
There are other IDEs out there, many of scenarios are given in subsequent sec-
which are compatible with the Mac as tions.



ibooks:///#chapterguid(19E7E181-8184-405F-9A07-314FFC19BDBB)
ibooks:///#chapterguid(19E7E181-8184-405F-9A07-314FFC19BDBB)
https://developer.apple.com/xcode/
https://developer.apple.com/xcode/
https://eclipse.org/
https://eclipse.org/
https://netbeans.org/
https://netbeans.org/
https://www.jetbrains.com/idea/
https://www.jetbrains.com/idea/
https://www.jetbrains.com/clion/
https://www.jetbrains.com/clion/

2.2 HOW TO LAUNCH XCODE

You must run Xcode in our software environment by launching it from the command

line.

Once Xcode is installed, you will have

an icon in your machine’s Applications
directory. But, to run Xcode for g-2 code,
it must be running within our software en-
vironment so that it has access to our en-
vironment variables. Therefore, you
should not start Xcode by clicking on its
icon. You must instead start it from the
command line by following the instruc-
tions here.

Prepare the environment. Launch a ter-
minal window (I like iTerm2) and re-
establish a session in a development
area. For example, see step 1 on the
right. If you haven'’t built the code before
or have zapped the build area, you
should run cmake from the command

line by following step 2.

Launch Xcode. Assuming you installed
Xcode in /Applications, follow step 3.

1 source /cvmfs/oasis.opensciencegrid.org/gm2/prod/g-2/setup
cd /path/to/my/dev/area
source localProducts*/setup

source mrb s # Set up development environment

2 mrb b -C # Runs cmake '
:3 /Applications/Xcode.app/Contents/Mac0S/Xcode & '

In your terminal screen, you will see messages from Xcode. These are benign, includ-
ing the ones that tell you to report Xcode bugs, and may be ignored.

10


http://iterm2.com/
http://iterm2.com/

2.3 CONFIGURING XCODE

Do these steps once for your development area.

profile-sim
~/Development/g-2/xcode

There are several steps that are re-
quired to configure Xcode for your devel-
opment area. You only need to follow
these steps once for each development
area that you are using.

[

MyPlaygroundA.playground
~/Development/g-2/xcode

migratev5_gm2analyses
~/Development/g-2/xcode

docs
~/Development/g-2/xcode

Create the Xcode project. Launch

Xcode (see section 2.2 for how). The WEICome 100 XCOde

welcome screen should appear (see Version 6.2 (6C107a)
right). If that doesn’t appear, then on the

mrb
~/Development/g-2/xcode

A

~/Development/g-2/xcode

SRR PP e

menu bar choose Window > Welcome to ?f;:vte‘lg'p‘fem o2 xcode
Xcod E Get started with a playground
coage. 47| Explore new ideas quickly and easily. ~ CMakelists.txt
7_ ...nt/g-2/migrateToV5/srcs/gm2ringsim/fcl
i i , ) Create a new Xcode project
- v, ;\1 x i
CIICk on Create a NeW XCOde prOJect /%] Start building a new iPhone, iPad or Mac application. ‘ W CMakelLists.txt
.| ~/Development/g-2/mrb/srcs/mrb
’;{ Check out an existing project - product_deps
Start working on something from an SCM repository U ...t/g-2/migrateToV5/srcs/gm2ringsim/ups

v Show this window when Xcode launches Open another project...

11


ibooks:///#chapterguid(F3159317-A9D0-484C-BEFF-DEE359112E48)
ibooks:///#chapterguid(F3159317-A9D0-484C-BEFF-DEE359112E48)

Choose the template. For the template,
choose OS X > Other and then External
Build System (as shown). Click Next.

Choose a template for your new project:

i0S
Application
Framework & Library
Other

0OSs X

Application
Framework & Library
System Plug-in

= &

In-App Cocoa- Empty
Purchase AppleScript

t

External Build
System

Other
External Build System
This template builds using an external build system.
mmCa0celm Previous

12



Choose project options.
Now fill in the options sheet.
For the product name, it is a
good idea to use the same-
name as your development
area directory.

The organization name and
identifier don’t matter. Put in
anything you like, but your
name is probably best.

For the build tool, enter
“‘make” as shown.

Click Next.

Choose options for your new project:

Product Name:

Organization Name

Organization Identifier

Bundle Identifier:

Build Tool

proﬁle-sim|

: ’Adam L Lyon

: ’Iyon

lyon.profile-sim

: [ make

Cancel

 Previous | HeH

13



Save the project. Now you must save
the project files somewhere. These files
are specially for Xcode and you should
not save them in your development area
nor put them in git.

| have a specific directory on my Mac
where | put all of my Xcode project files
called ~/Development/g-2/xcode. You
may want to do the same. Xcode will
automatically add a directory there
named by the product name for your pro-
ject.

Be sure the “Create Git repository”
check box is unchecked. You don’t need
a new git repository - your sources al-
ready have git repositories and Xcode
will use them.

Click on Create.

No figure necessary

14



B2 <« » [ profile-sim

] Info Build Settings Build Phases
Pj:rizle-sim Vv External Build Tool Configuration
TARGETS Build Tool | make
Arguments ‘ $(ACTION)
Directory | ${MRB_BUILDDIR] © | dp—

 Pass build settings in environment

Configure the project.The main project
screen will now appear. First, in the Ex-
ternal Build Tool Configuration section,
for the Directory enter $ {MRB_BUILDDIR}
in the box. Because you started Xcode
from the command line with your devel-
opment environment set up, Xcode will
know about that environment variable.

Start the documentation target. Unfor-
tunately, an external build system pro-
ject will not activate Xcode’s nice source
code navigation system. To remedy this
situation, we will add a documentation
target. Start this process by clicking on
the + sign in the left corner underneath
Project and Targets.

15



The idea here is to create a fake li-
brary target so that Xcode will activate
its source code navigation features.
We won't actually use the library target
for anything important.

Choose the target template. Under
OS X choose Framework & Library
then choose Library.

Click Next.

Choose a template for your new target:

i0S
Application
Framework & Library
Application Extension
Other
Apple Watch

0OS X
Application
Framework & Library
Application Extension
System Plug-in
Other

~
&
Cocoa

Framework

<

Bundle XPC Service

Library

This template builds a library that links against the Cocoa framework.

Cancel

Previous

16



Choose target options. For the target
options, first input a product name. |
typically use the same name as the pro-
ject with “-docs” at the end.

The organization name and identifier
typically don’t mean anything, so just
put in your name.

For Framework, choose None (Plain C/
C++ Library).

For Type, choose Dynamic.

The Project should be automatically
filled in.

Click Finish.

Choose options for your new target:

Framework

Type

Project

Product Name:
Organization Name:

Organization Identifier:

Bundle Identifier:

proﬁle—sim—docsl

’Adam L Lyon

’Iyon
lyon.profile-sim-docs

:  None (Plain C/C++ Library)

A
v

: | Dynamic

| —
:,\Q...

: & profile-sim

A
v

- Cancel |

. Previous | [-—F'mish—-]

17



Now, we have to tell Xcode where
header files for Art, Geant4, and other
packages live. | have a little script that
tries to make this easy.

Define the header search paths. You
should now be back to the main Xcode
screen with the target information dis-
played. Be sure that “All” and “Com-
bined” are selected as shown on the
right.

Now enter header in the search box.
You should see a section appear
called Search Paths and within that an
entry called Header Search Paths.

Double click on the value of the
Header Search Paths; that is double
click on the words /Application/. ..

B2 <« » |3 profile-sim

]
PROJECT
profile-sim
TARGETS

profile-sim
W

* * Build Settings Build Phases
Basic | Levels | +

V Architectures
Setting
Base SDK

V Build Locations

Setting

Precompiled Headers Cache Path

V Build Options
Setting

Precompiled Header Uses Files From Build Directory
Scan All Source Files for Includes

V Packaging
Setting
Info.plist Preprocessor Prefix File
Private Headers Folder Path

Private Module Map File
Public Headers Folder Path

V¥ Search Paths
Setting
Always Search User Paths
Framework Search Paths
Header Search Paths
User Header Search Paths

V Apple LLVM 6.0 - Language
Setting

Increase Sharing of Precompiled Headers
Precompile Prefix Header

Prefix Header

Use Standard System Header Directory Searching

Vv Apple LLVM 6.0 - Language - Modules

Build Rules *

Q- header|

&g profile-sim-docs

Latest OS X (OS X 10.10) ¢

&g profile-sim-docs

/var/folders/5x/gycq58657glgm_2y27bfzy040000gp/...

&2 profile-sim-docs

Yes %
No ¢

By profile-sim-docs

Jusr/local/include

/usr/local/include

B profile-sim-docs

No &

—* /Applications/Xcode-Beta.app/Contents/Developer/To...

B profile-sim-docs

No &
No &

Yes 4




When you double click on the value
of the Header Search Paths, a box
should appear.

Click on the “+” in the lower left cor-
ner.

In the new entry box, enter
${MRB_SOURCE} and press enter.

Click somewhere outside of the box
to close it.

Now, back in your terminal window
you used to start Xcode, enter the
command on the right.

Now return to Xcode. You should see

“No Editor” displayed on the screen.

Precompiled Header Uses Files From Build Directory  Yes ¢ ‘ Widths |

A

Scan All Source Files for Includes — Tab
$(inherited) non-recursive v Wrap li
¥ Packaging /Applications/Xcode-Beta.app/Contents/Developer/Toolchains/Xcode... non-recursve | L
${MRB_SOURCE} non-recursive
Setting
Info.plist Preprocessor Prefix File
Private Headers Folder Path
Private Module Map File
Public Headers Folder Path
chang
V Search Paths
Setting I
Always Search User Paths + - | .
Framework Search Paths = {}
P Header Search Paths /Applications/Xcode-Beta.app/Contents/Developer/To...
User Header Search Paths ' C Block typed
{ } a type.

Vv Apple LLVM 6.0 - Language

$MRB_DIR/bin/xcodelncs.sh /path/to/xcode/project '

# Example below
$MRB_DIR/bin/xcodelncs.sh ~/Development/g-2/xcode/profile-sim

19



® OO0
D 1 | © profile-sim ) E My Mac

HE QA =Eo 8

Add sources to your project. The final step is to
add the source code to your project. Control-click
(right click) on the project name in the left hand bar

and choose Add Files to “<project name>". SIDEIE » L) ERTE :) (@
FAVORITES ™ [ build_d13.x86_64 > artg4 >
. = ; " localProduct..._00_e6_prof ™ | CMakeLists.txt
Or, you can also choose from the Menu bar, File > A Fles - GSEIEE D [ dependency,is
. “ . 7 ¥\ Applications > [ gm2analyses >
Add FIIeS tO <prO.IeCt name> - E Desktop > * . gm2dataproducts >
[} Documents " o~ 9m§9e°m "
. iy s > . gm2ringsim >
First (because it is easy to forget), check the box {5 Development . smerns
next to your documentation target (as shown on the i Dropoox omzanases
. ) Downloads .
rlght)' DEVICES 12_02 >
Remote Disc "
Now navigate to where your srcs directory lives and L] Xcode = .
select it.

Destination: | | Copy items if needed

In the Project Navigator pane (on the far left) a srcs Added folders: (s) Create groups
) Oc folder ref
directory should have been added. reate 1 No tditor -

Add to targets: @ profile-sim
™ & profile-sim-docs

The activity area (center top) may say “Indexing” *
Xcode configuration is now complete!

If you quit Xcode and start it again, you can get back
to your project by selecting it on the right side of the
welcome screen. (_ New Folder |

. Cancel | [ Add J

20



2.4 HOW TO LAUNCH INSTRUMENTS

Run Xcode first, then select Instruments

Running Instruments is easy once you m File Edit View Find Navigate Editor Product D

already have Xcode running. Follow the ~ About Xcode 0o

instructions in Section 2.2 for launching .

Xcode. e Preferences... 3, ? B | © profile-sim ) Bl My Mac
> EI‘ Behaviors > B =E QA O = =3 =
MLB Open Developer Tool > ) Instruments

You may then launch Instruments from eJ | Services > " i0S Sirr'mu'létor

the menu bar by choosing Xcode > o Hide Xcode ey | @ Accessibility Inspector

Open Developer Tool > Instruments, as Hide Others T®H FlleM.erg'e

shown on the right. e § Show All © Application Loader

Again, you should not start Instruments o 'f Quit Xcode #Q Motaievsiopan Toois-=

7 dependency_list

by clicking on its icon. You need to start _Usage: xcode-select
it within Xcode so that it will be in the
same software environment as Xcode.

See later sections about how to run In-
struments.
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3.1 QUICK TOUR

The picture at the right is a gen-
eral display from Xcode editing
source. Refer to the numbers for
explanations. Hovering the
mouse cursor over something
will often give you help on that
item.

1) Activity bar. This bar shows
any activity from Xcode (build-
ing, indexing, debugging)

2) Standard Editor. This is the
main editor window for source
code.

3) Jump bar. Clicking parts of

e 00
> |l | profile-sim » & My Mac

- o calculateDriftTime_module.cc — Edited
~  profile-sim: Ready | Today at 10:12 AM

6 7 e
Edd O=Z0

B &g QA o 2o &
@ profile-sim
2 targets, OS X SDK 10.10
v [_]srcs
| .cmake_add_subdir
" .cmake_include_dirs
_ .mrbversion
» [ Jartgd
| CMakeLists.txt
| dependency_list
» || gm2analyses
» || gm2dataproducts
» | _|gm2geom
» || gm2ringsim
» || Products

1 // ar es

14 #include "art/Framework/Core/EDProducer.h"

15 #include "art/Framework/Core/ModuleMacros.h"

16 #include “art/Framework/Principal/Event.h"

17  #include "art/Framework/Services/Registry/ServiceHandle.h"

ata product includes

20 #include “gm2dataproducts/strawtracker/TrackerHitArtRecord.hh"
21 #include “gm2analyses/strawtracker/util/DriftTimeUtility.hh"

23 using std::endl;

Do all this in the =tracking analysis* namespace

26 namespace gm2strawtracker {

class calculateDriftTime; 2

31 // including the e)
32 class gm2strawtracker::calculateDriftTime : public art::EDProducer {

public:
explicit calculateDriftTime(fhicl::ParameterSet const & p);
virtual ~calculateDriftTime();

BB <« » @ profile-sim » | s _1g)| s . calculateDriftTime_module.cc » [[] gm2strawtracker::calculateDriftTime::calculateDriftTime(fhicl::ParameterSet const & p)

3

0O o

Identity and Type 5

Location | Relative to Group

Type | Default - C++ Source

Name | calculateDriftTime_module.cc

calculateDriftTime_modul

e.cc -

Full Path fUsers/lyon/Development/

g-2/profile-sim/srcs/
gm2analyses/strawtracker/
calculateDriftTime_module.
cc

‘ Target Membership

profile-sim
™ & profile-sim-docs

Text Encoding | Unicode (UTF-8)
Line Endings | Default - OS X / Unix (LF) * |

Indent Using | Spaces

‘ Text Settings

Widths 2|5 2|5

Tab i Indent
@ Wrap lines

‘ Source Control

void produce(art::Event & e) override;

private:

/ and
| trmg thoduleLabeL g
string instanceName_;

r declaration

/ Constructor gets ete from the FHiC

49 ngStrawtracker caLcuLateDrlftTme calculateDrxftTme(fhlcl ParameterSet const & p)
: hitModuleLabel_ ( p.get<std::string>(" hltModuleLabel
instanceName_ ( p.get<std::string>("instanceName"

d th hl', jata, we need the name of the module that produced it

Repository --
Type --
Current Branch --

Version --
Status Modified | Discard...
Location
1} ®

{ } C Block typedef - Define a block as

the jump bar allows you to
quickly navigate to different
parts of the code or other files.
You can filter by clicking and
then typing. Clicking The left
and right triangles allow you to
cycle backwards and forwards
through viewed code. The four
square thing to the left of the tri-
angles is very useful. It is a con-
text sensitive list of associated

files (e.g. the counterpart file, which is the
.h or .cc).

// Tell art what we'll be putt n the event. atype.

produces<TrackeertArtRecordCollect1on>()
}

hing much C Inline Block as Variable - Save
g I { } a block to a variable to allow reuse or
{ passing it as an argument.
C dyn d
}
C def - Define a def.

// produ lled once for each event, and it adds a hit collection to {} type e

// the art event

65 void gm Zstrawt acker :calculateDriftTime: :produce(art::Event & e)

8B ®

6) Editor chooser. Brings up different
editors. The version editor (right most)
is very useful.

4) Navigator bar. Currently showing the pro-

Ject navigator. Note the “M” indicates that a
file in that directory was modified and has

not been committed to git.

5) Utility bar. Currently showing the file in-
spector. | find this bar less useful.

7) Bar chooser. Can make the naviga-
tor, debug, and utility bars disappear
and re-appear.

8) View restrictor. Restricts what you
see in the navigator view.

23



3.2 NAVIGATING SOURCE CODE

Xcode makes reading and exploring code very easy

Here are some tips for navigating in
Xcode.

« 3 Click (click while holding command
key) on an include file, a class name,
or an object name will take you to the
source for that include or class/object.
Option-38 Click will open an “assistant”
editor instead of changing the stan-
dard editor. This feature is one of the
best in Xcode.

« The assistant editor is an editor win-
dow that is associated with the stan-
dard editor and reacts to what you do
in the standard editor. You can use the
jump bar to configure the assistant edi-
tor. For example, choosing “counter-
part” will show the .h or .cc file that cor-
responds to the file in the standard edi-

for. You can have as many assistant
editors as you want. You can configure
where they initially appear in View >
Assistant Editor. Assistant editors are
very useful once you figure out how to
use them (and are an unusual feature
not found in other IDEs). There are
also nice keyboard short cuts. A handy
one is ¥ Return, which will close all of
the assistant editors you have open
leaving you with only the standard edi-
tor.

To edit multiple files in fabs, you use

#6 T to open a new tab. The new tab
will initially be identical to what you just
had open. Use 3 {and 3} to cycle
through tabs.

« Play with the version editor to view dif-

ferent git versions of the source files
and their differences. This feature is
extremely useful.

 Right (or Control)-Click on text in an

editor brings up a wealth of actions.
The Show Blame for Line will show
you who entered/last changed that line
and the git commit.

« Remember to use the jump bar to

quickly move around the file.
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3.3 SEARCH AND REPLACE

Searching and replacing code at the file or project level is easy

One of more important features of an
IDE is finding text as well as searching
and replacing. Xcode is extremely capa-
ble in this area

Many actions are available from the
Find menu. To do file level find/search &
replace do #F.

Project level find/search & replace is es-
pecially useful. To activate the Find Navi-
gator select the search icon on top of
the navigator bar (as shown selected on
top in the figure on the right).

You may now enter the search string in
the text box. Clicking on Find, Text, Con-
taining, and the search icon in the bar
brings up a wealth of options (click Find
to see replace actions). There are also

more options below the text bar, includ-
ing if you want to restrict the search to
certain files.

The results are shown below. Clicking
on a result will bring it up in the standard
editor (option-click will bring up an assis-
tant editor).

You can remove results by clicking on
them and pressing Delete. Doing so
does not change any file, it simply re-
moves the result from the Find Naviga-
tor.

Many search and replace options and
actions are available here.

® 00
’ M [ profile-sim » & My Mac

B RS Q&N © £ o B

Find » Text » Containing

Q- G4cout
=== |n Project Ignoring Casey

1239 results in 62 files

Arc_service.cc
& profile-sim project

[ G4cout << "=========== Arc (Storage Ring
- Field) ===========" << G4end|,
G4cout << "| Beam Charge =" << sts_.Get
~ Charge() << Gdend|;
|j| G4cout << "| Spin Tracking =" << spin_tracking
_ << Gdendl;
[] G4cout << "| EDM Tracking =" << edm
~ _tracking_ << Gdendl;
G4cout << "| Storage Field =" << sts_.Cet
~ StorageFieldType() << G4dend|;
|| G4cout <<
================" << G4end|;

GC4cout << "Could not set up Mag Stepper: " << sts
~ _.GetStepperName() << "." << Gdendl; exit(1);
if ( mag_stepper ) { G4cout << "Set up Mag Stepper: *
<< sts_.GetStepperName() << "." << Gdend|; }
[ G4cout << "Using StepSize: " << stepsize/mm << "
- mm." << Gdend|;
|| G4cout << "Using StepSize: " << stepsize/mm << "
- mm." << Gdendl;
G4cout << "Could not set up Mag Stepper: " << sts
~ _.GetStepperName() << " w/ spin." << G4endl; exit
(1);
if ( stepper ) { G4cout << "Set up Mag Stepper: " <<
~ sts_.GetStepperName() << "w/ spin." << Gdendl; }
G4cout << "Could not set up Mag Stepper: " << sts
~ _.GetStepperName() << " w/ spin." << G4endl; exit
(1)
if ( stepper ) { G4cout << "Set up Mag Stepper: " <<
~ sts_.GetStepperName() << "w/ spin." << Gdendl; }
ArtG4RunManager.cc
& profile-sim project
| Gaint oldPrecision = G4cout.precision(3);
[ std:ios::fmtflags oldFlags = G4cout.flags();

|| G4cout.setf(std::ios::fixed,std::ios::floatfield);
(] G4cout << "TimeEvent> "

|| G4Acout.setf(oldFlags);

| G4cout.precision(oldPrecision);
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3.4 GIT INTEGRATION

Xcode has extensive integration with git

Git indicators. The Project Navigator
bar gives several clues to the state of
files in git.

1) Files that have been modified, but un-
saved, have their file icon in grey.

2) Files that have a git status are indi-
cated by a grey letter in the right side
of the bar.

« M file was modified
» A file was added
o D file was deleted

Such files have not been committed yet.

® OO0
> H | profile-sim » & My Mac

B & QA © o B

—

 .cmake_add_subdir

| .cmake_include_dirs
" .mrbversion
» | _|artg4
"~ CMakeLists.txt
 dependency_list
v | |gm2analyses
» [ ]calo
* CMakelLists.txt
» | | DisplayDataProducts
> [_]fcl
v [ | strawtracker
o addGeometryToHits_module.cc
1 @ calculateDriftTime_module.cc
| caloEnergy.fcl 2
o CaloEnergy_module.cc
| caloEnergyStudy.fcl
| caloHitLocator.fcl
| CMakeLists.txt
~ drawStationHits.fcl
o dummyFit_module.cc
| examineHits.fcl
o examiner_module.cc
| find-and-make-golden-trackerevts.fcl 2
" findHitsPerView.fcl -
o FindHitsPerView_module.cc
_ findPositronEvents.fcl
" findUseableEventWithTrackerHits.fcl
" findUseableMCEvent.fcl
'] getTO.fcl
o GoodPositron_module.cc
o GoodPositronCaloLocator_module.cc
o GoodPositroninSameCaloTracker_module.cc
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000 | find-and-make-golden-strawevts.fcl

D B | © profile-sim ) Bl My Mac profile-sim: Ready | Today at 10:12 AM E’ ﬁ Z [ I:| E

B D = < » [ profile-sim » [ ] srcs » [ | am2analyses » || strawtracker ) ¢ calculateDriftTime_module.cc » No Selection
[‘E] profile-sim 37 void produce(art::Event & e) override; 37 void produce(art::Event & e) override;
2 files changed = " :
private: 39 private:
v [srcs 40
v |__|gm2analyses 41 // To find the hit J we need the name of the module that produced it 41 'o f d > hit d we need the name of the module that produced it
~ 42 tance 2 // an
Y \_thramracker tring 1tModuleLabel H 43 std strmg h.\tModuleLabel H
m e tring instanceName_; “ std::string instanceName_;
4 7 fin...s.fcl 4
= }; / 4% }; // End pr er declaration
48 / Cons ctor C" parameters from the FHi c file 48 / Constructo rame s from the FHi c
w9 grz trawtracker::calculateDriftTime: calculateDrLftTuﬂe( h cl: ParareterSet w9 gmzstrawtracker calculatebrxftTme calculateDrxftTme(fhlcl ParameterSet
const & p) const & p)
50 :  hitModuleLabel_ ( p.get<s td string> ( hitModuleLabel”, "artg4" ) ), 50 ¢ hitModuleLabel_ ( p.get<std::string>("hitModuleLabel", "artg4" ) ),
51 instanceName_ ( p.get<std: t ing> ( stanceName", " St raws")) 51 instanceName_ ( p.get<std::string>("instanceName", ”Straws"))
2 { 2 {
53 // Tell art wl ! be put the event. 53 // Tell art what we'll be putting in the event.
54 produces<Trar.keertArtRecordCouecuon () 54 produces<TrackerHitArtRecordCollection>();
55 55}
P tor; nothing much to do here w2/ r; nothi ch her
58 58 gm2stramracker calculateDrxfthme ~calculateDr1ftT1me()
ic memory and other resources here. // Clean up dynamic memory and othe
61 61}
) = fo , and it adds a hit collection to 5 // pr udw,u ...) is called once for each event, and it adds a hit collection to
] - - 4 64 // the
calculateDriftTime: :produce(art::Event & e) 65 void m2$trawtracker :calculateDriftTime: :produce(art::Event & e)
Checking in commits. When you have ’ ) poid's »
67 // Get and fill handle, then resolve it so we actually have a 67 C l and VM.L :1 ‘\(n‘dl-':, then resolve it so we actually ha
d-f- d f-I -t th t 68 // collection hits 68 / Le:
l I I ' I I l I ” I I I I l 69 art::Handle<TrackerHitArtRecordCollection> hitDataHandle; 69 art Handle T acke HltArtReco rdCollection> hitDataHandle;
O I Ie I eS’ you ay CO I e 0 70 e.getBylLabel(hitModuleLabel_, instanceName_, hitDataHandle); 70 e.getBylabel(hitModuleLabel_, instanceName_, hitDataHandle);
7 TrackerHitArtRecordCollection const & hits = xhitDataHandle; 71 TrackerHitArtRecordCollection const & hits = =hitDataHandle;
. . . 7 n
your local git repository. You can commit R /7 Create the collection ve'LL a0 to the evet R —— .
7% std::unique, ptr<Tracker—i tArtRecurdCollect ion> 74 std: umque ptr<TrackerH1tArtRecordCollect10n>
. .. . . 75 newﬂxts(new TrackerHitArtRecordCollection); 75 newHits(new TrackerHitArtRecordCollection);
individual files by Right (or Control)- | /7 cotcutote the o get the hit cotlection m| /7 cotcutote the arite +imes and et the it coec
78 *newHits = DriftTil i ulateDriftTim (hits); 78 newﬂns = DrlftTmeUtxuty :calculateDr1ftTmes(hns)
I' k h f'I H h N H 80 // Put thes the event 80 // Put thes the event
IC On e I e In e avlga Or ar_ 81 e.pu t( td: :mov e(newHJ.ts)) 81 e.put(std: move(nelets))
82 } 82 }
83 83
You Can Commit a” Of the modified fiIeS 84 DEFINE_ART_MODULE(gm2strawtracker::calculateDriftTime) 8 DEFINE_ART_MODULE(gm2strawtracker::calculateDriftTime)
— gm2analyses » " develop » (L) Local Revision 4 2 » gm2analyses » " develop » (L) 10/29/13 Leah Welty-Rieger 7ccd790489d3 (BASE, HEAD)
by choosing from th S C
. . . Enter commit message here
trol > Commit... A sheet similar to the

one on the right will appear. (o)

On the commit sheet you will see, on on the center-column indicator. Scroll up the lower left. Be sure you have an ac-

the left, a navigator bar showing the and down to see all of the changes. tive kerberos ticket to push.
changed files to be committed. Clicking

on the checkbox will add/remove that

file from the commit. The main part of
the sheet shows a version editor where
you can see the changes you made for
a particular file. You may remove particu-
lar changes from the commit by clicking

You type your commit message in the Explore the Source Control menu for
block on the bottom of the sheet. many more actions and options.

If you want to push to remote reposito- Merging is particularly useful in Xcode,
ries (Redmine) at the same time as com- because a very helpful merge conflict
mitting, check the Push to remote box in editor will open if necessary.

27



3.5BUILD

Xcode’s build error display is very useful

e 00
‘1 » H | profile-sim » & My Mac

|5 profile-sim.xcodeproj

Building profile-sim: profile-sim | Running external build tool

]

EdyE LDl

B2 Q A © o @
CIETD 8y Time 2

profile-sim o
v Today, 12:43 PM

B8 <« » © profile-sim » Build profile-sim
Recent

@ Build target profile-sim
Project profile-sim | Configuration Debug | Destination My Mac | SDK OS X 10.10
¥ # Run external build tool

Errors Only

| All Messages All Issues

®

Today, 12:43 PM

’Build
1/9/15, 12:15 PM

Project
v B 10015, 1051 am

>Debug gm2
1/11/15, 1:51 AM

If you have configured Xcode correctly,
you can build the code by clicking on the
big right triangle in the upper left hand
corner (1) in the figure above.

To see the build log, click on the Log
Navigator (2).

The build log shows a subset of the log
output and is not particularly useful. To
see the entire log, select the little icon
as shown in (3) on the same line with
“‘Run external build tool”. Look at the
green shaded output.

-~ Product is artg4 v2_00_00 e6:prof
-~ Module path is fcvmfs/oasis.opensciencegrid.org/gm2/prod/external/art/vl_12_02/Modules;/cvmfs/oasis.opensciencegrid.org/gm2/prod/external /cetbuildtools/v4_03_02/Modules
-~ set_install_root: PACKAGE_TOP_DIRECTORY is /Users/lyon/Development/g-2/profile-sim/srcs/artg4
-~ Building for Darwin d13 x86_64

-- set_install_root: PACKAGE_TOP_DIRECTORY is /Users/lyon/Development/g-2/profile-sim/srcs/artg4
-- Selected diagnostics option CAUTIOUS

You will also note that the Action Bar in-
dicates that the build is in progress.

8006
P [0 | @p.  BEMma

Errors will be indicated in many

profile-sim | Build profile-sim: Failed | Today at 12:44 PM

A

BEdiFEd OO

& calculateDriftTime_module.cc

0!

BR QA& =p B
CEIy o e

profile-sim
v @ 1 issue o

places, including as an icon the
Action Bar. Clicking on that
icon will take you to the /ssue
Navigator. Clicking on an issue
will show you the error in the
source code (see right). This
feature is extremely useful.

¥ g calculateDriftTime_module.cc

" Expected unqualified-id before {’ token

If the build is successful, you

can run gm2 from the com-

mand line (not from within
Xcode).

28 | @4 » | [f profile-sim » [ ] srcs > [ ] gm2...yses » [ ] stra...acker ) . calculateDriftTime_module.cc » No Selection < @ »

21 #include "gm2analyses/strawtracker/util/DriftTimeUtility.hh"
2

23 using std::endl;

25 // Do all this in the

stracking analysis namespace

26 namespace gm2strawtracker {

% }; // End producer

30 // Declare the class here (not in a .hh

class calculateDriftTime;

file, to prevent you from (sanely)
he file)

// includil L
tracker::calculateDriftTime : public art::EDProducer {

class gm2s
public:
explicit calculateDriftTime(fhicl::ParameterSet const & p);
virtual ~calculateDriftTime();

void produce(art::Event & e) override;
private:

// To find the hit data, we need the name of the module
// and an instance name.
std::string hitModuleLabel_;
std::string instanceName_;

that produced it

declaration

// Constructor gets parameters from the FHiCL configuration file
gm2strawtracker::calculateDriftTime::calculateDriftTime(fhicl::ParameterSet const & p)
:  hitModulelLabel_ ( p.get<std::string>("hitModuleLabel", “artg4" )

instanceName_  ( p.get<std::string>("instanceName", “Straws"))

// Tell art what we'll be putting in the event.
produces<TrackerHitArtRecordCollection>();

}

// D t h ch do h

{ © Expected unqualified-id before ' token
// Clean dyr mory and other resources h

}

// produce( ) is called once for each event, and it adds a hit collection to

// the art even

65 void gm2strawtracker::calculateDriftTime::produce(art::Event & e)
{

and fill a handle, then resolve it so
ction of hits
e<TrackerHitArtRecordCollection> hitDataHandle;

we actually have a
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3.6 DEBUG

Debugging within Xcode can show you how your code works

Some notes. Debugging our g-2 code
on a Mac has limitations. Apple does not
use gdb for debugging. Rather, it uses
LLDB, which is tied to the LLVM com-
piler (we use gcc instead). Many things
work, but somethings don’t and LLDB
can crash if you view certain objects.
Simply restart Xcode and you’ll be run-
ning again.

Another limitation is that on the Mac,
connections from code to the source are
not stored in libraries. Therefore, if you
want to debug into source code, you
must build that code yourself. Typically,
this is not a problem as Art and Geant
code are complicated and do not lend
themselves for easy debugging. If you
are debugging and see assembly code

instead of C++ source, that is because
the connection to the source is not avail-
able. All code you build yourself is de-
buggable.

Lastly, debugging code built in a prof re-
lease will work, but stepping through
code will seemingly be crazy as the cur-
rent line pointer will jump around. Fur-
thermore, break points that you set may
never get hit. This problem is because
prof builds are optimized. Code you see
in the source file may have been altered
or removed by the compiler optimizer.

If you are exploring the operation of
some code, you should use a debug
build (no optimization).

29



To set breakpoints you can sim-
ply click on a line number in the
source (2).

You can also click on the Break-
point Navigator (1) and see a
list of set breakpoints.

You can right (or Control-) click
on the break point and edit it.

At the bottom of the navigator
you can also set special break-
points, such as exception break-
points. Those are especially use-
ful if Art or your code is throwing
an exception.

® O O
» 1 | © debug) E My Mac

o makeSimpleTracksFromOIdHits_module.cc
debug | Build debug: Succeeded | Today at 11:39 PM

B &= Q& © =p B

m, debug ‘1
v 1 Breakpoint

V¥ c. makeSimpleTracksFromOIdHits_m...
[7) artex::MakesS...art::Event &e) [

3
Add Exception Breakpoint
Add OpenGL ES Error Breakpoint
Add Symbolic Breakpoint...
Add Test Failure Breakpoint

1 R —

52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95
96
97
98
99
100
101
102
103
104
105
106
107
108
109
110

B o« » @ debug ) srcs ) gm2artexamples ) | Lesson2 ) c. makeSimpleTracksFromOIldHits_module.cc ) No Selection

std::rstring hitsModuleLabel_;
std::string hitsInstancelLabel_;

unsigned int madeNTracks_;
unsigned int madeNHitsOnTracks_;
unsigned int nEvents_;

1

// Constructor

artex::MakeSimpleTracksFromOldHits: :MakeSimpleTracksFromOldHits(fhicl::ParameterSet const &p) :

engine_( createEngine(get_seed_value(p)) ), // Use a "seed" parameter if there is one
hitWeightGreaterThanThis_( p.get<float>("hitWeightGreaterThanThis", 0.5 )),
hitsModuleLabel ( p.get<std::string>("hitsModuleLabel")),

hitsInstanceLabel_( p.get<std::string>("hitsInstanceLabel")),

madeNTracks_(@), madeNHitsOnTracks_(@), nEvents_(0)

// We have to declare what this producer is producing
produces< artex::SimpleTrackDataCollection > ();

}

// The produce method does all the work
void artex::MakeSimpleTracksFromOldHits::produce(art::Event &) {

// In reality, tracking finding is a complicated process. Here, we're just going to do something stupid
// and pick hits and values semi-randomally. We really want to show how @Ptr@ works instead of tracking algorithms.

// Make our random number generators
CLHEP: :RandFlat flat( engine_ );
CLHEP: :RandGaussQ gauss( engine_ );

// Make the empty collection we're going to fill with our created tracks
std::unique_ptr< SimpleTrackDataCollection > tracks( new SimpleTrackDataCollection );

// Let's decide how many tracks to make
unsigned int nTracks = flat.fireInt(5);

mf::LogDebug("MakeSimpleTrackFromOldHits") << "Making " << nTracks << " tracks";

// Let's pull the hits out of the event.
art::Handle< HitDataCollection > hitsHandle;
e.getByLabel( hitsModuleLabel_, hitsInstanceLabel_, hitsHandle );

// Lopp to create the tracks
for ( unsigned int iTrack = @; iTrack < nTracks; iTrack++ ) {

// Let's loop over the hits and randomally assign them to this track. We'll also
// apply a cut on the weight of the hit.
// Note that we're going to start out by making the hit a @Ptr@

// Make an empty @PtrVector@ to hold the hits that will make up our track
art::PtrVector< HitData > desiredHitPtrs;

// Remember that @>@ on a handle pretends that it is a pointer to the object
for ( unsigned int iHit = @; iHit < hitsHandle->size(); iHit++ ) {

// Pay close attention to how we're going to get the hit. We could simply
// dereference the handle to get at the real hit collection vector and

// loop over that. BUT, since we eventually want the Ptr to the hit to put
// in the track, instead we'll make a @Ptr@ right off the bat. Since

// @Ptr@ needs to know how to store data, it really wants to know about the
// handle and where in the collection you are associating. Hence,
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Cr+ makeSimpIeTracksFromOIdHits_module.cc
debug | Build debug: Succeeded | Today at 11:39 PM

@l s.) i iFromOldHits::
hitsMmodu  PID or Process Name gm2 r
hitsInst If you enter a process name that isn't currently running, the
debugger will wait for that process to start (for example, by you
t madeNTr launching it from the Dock or Finder).
t madeNHi
To run the debugger, you must attach to tnEventy Debugger | LLDB *
the running process. You can set up Debug Process As (*) Me (lyon)
Xcode by choosing from the menu De- leTracksF Oroot
bug > AttaCh tO PI'OCGSS > By PrOCGSS teEngine( Use this option to debug a root process.
o terThanTh
Identifier (PID) or Name... el_( p.ge . Cancel | | Attach |
abel_( p. ’
9), madeN

Enter gm2 for the process name. Then

; ; i declare what this producer is producing
click on Attach (Xcode will wait for the ex: :SimpleTrackDataCollection > ():
process to start).

The first time you try to attach, Xcode
may suspend itself. Go to the terminal
and do bg to resume Xcode in the back-
ground.

gm2 -c makeTracksFromOldHits.fcl

You should see Waiting for gm2 to
Launch in the activity bar.

Then start gm2 in the terminal. For ex-
ample,
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The debugging screen is shown here.

You can advance through the program
by continuing (1), stepping over func-
tions (2), stepping into functions (3),
and stepping out of the current func-
tion (4).

You can view current variables to-
wards the bottom of the window.

You can also hover the mouse over
objects and variables in the source
code to see values.

If you see assembly code instead of
source code, then you are looking at
code that you didn’t build.

® O 6 ¢, makeSimpleTracksFromOIldHits_module.cc 2
p ®
P> B | © debug) E MyMac Running gm2 E 7 | L&=LE
B 2 Q A & = b B3 08 <« » | [ debug )| srcs )| gm2artexamples ) | | Lesson2 ) ¢. makeSimpleTracksFromOldHits_module.cc ) No Selection
gm2 54
'-p”) 78710, Paused @ b 55 unsigned int madeNTracks_;
- 56 unsigned int madeNHitsOnTracks_;
CPU 0% | 57 unsigned int nEvents_;
58 };
59
ey ] o // Constructor
(L[ [T[]]] 61 artex::MakeSimpleTracksFromOldHits: :MakeSimpleTracksFromOldHits(fhicl::ParameterSet const &p) :
= Energy Impact Very High | ©2 engine_( createEngine(get_seed_value(p)) ), // Use a "seed" parameter if there is one
63 hitWeightGreaterThanThis_( p.get<float>("hitWeightGreaterThanThis", 0.5 )),
[ 64 hitsModuleLabel_( p.get<std::string>("hitsModuleLabel")),
;@ Disk 8 KB/s| 65 hitsInstanceLabel_( p.get<std::string>("hitsInstanceLabel")),
1 66 madeNTracks_(@), madeNHitsOnTracks_(@), nEvents_(0@)
67 {
3 Network Zero KB/s | 68 // We have to declare what this producer is producing
69 produces< artex::SimpleTrackDataCollection > ();
70
v Thread 1 " ¥

=% Queue: com.apple.main-thread (serial)
m| 0 artex::MakeSimpleTracksFromO

[ 1 art::EDProducer::doEvent(art::Ev...

41 start
> w1 Thread 2

EEE® D)

72 // The produce method does all the work
73 void artex::MakeSimpleTracksFromOldHits::produce(art::Event &) {

74
75 // In reality, tracking finding is a complicated process. Here, we're just going to do something stupid
76 // and pick hits and values semi-randomally. We really want to show how @Ptr@ works instead of tracking algorithms.
77
78 // Make our random number generators
CLHEP: :RandFlat flat( engine_ );
80 CLHEP::RandGaussQ gauss( engine_ );
81
82 // Make the empty collection we're going to fill with our created tracks
83 std::unique_ptr< SimpleTrackDataCollection > tracks( new SimpleTrackDataCollection );
84
85 // Let's decide how many tracks to make
86 unsigned int nTracks = flat.fireInt(5);
87
88 mf::LogDebug("MakeSimpleTrackFrom0ldHits") << "Making " << nTracks << " tracks";
89
90 // Let's pull the hits out of the event.
91 art::Handle< HitDataCollection > hitsHandle;
92 [} e.getByLabel( hitsModuleLabel_, hitsInstanceLabel_, hitsHandle ); Thread 1: step over
93
9k // Lopp to create the tracks
95 for ( unsigned int iTrack = @; iTrack < nTracks; iTrack++ ) {
9%
97 // Let's loop over the hits and randomally assign them to this track. We'll also
98 // apply a cut on the weight of the hit.
99 // Note that we're going to start out by making the hit a @Ptr@
100
101 // Make an empty @PtrVector@ to hold the hits that will make up our track
102 ft::["yVed r</AitData > desiredHitPtrs;
103 1 g 3 4 '
= ™» > 4o L 2T Mgm2) w Thread 1) |1 0 artex::MakeSimpleTracksFromOldHits::produce(art::Event&)

> E\ this = (MakeSimpleTracksFromOldHits *const) 0x7f9al1af8f130 (1ldb)
> hitsHandle (Handle<vector<HitData, allocator<artex::HitData> > >)
@ nTracks = (unsigned int) 3
> L] flat (RandFlat)
Auto 5 | © (D (@ )| AllOutput r (e
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Using Instruments

« Configuring Instruments

« Time Profiler

« Mlemory Allocation and Leak Profiler



4.1 CONFIGURING INSTRUMENTS

Configure Instruments to run “gmz2”

See section 2.4 for how to launch Instruments.

When it starts up, you will see a screen like the one on the up-

per right, allowing you to select a profiling template for an ex-
ecutable.

Your screen will have some default executable. Click on it to
bring up the chooser, select your Mac laptop as the device,
and select Choose Target...

You now need the location of the gm2 executable. In the ter-
minal where you ran Xcode, do

which gm2

Copy the results to the clipboard with 3 C.Then go back to
the instruments window and press Shift-3 G to open a path
box. Paste the results with 3V and press Go. (Note this path
box works for any file open window in any Mac application).

Next, choose the the gm2 executable.

See the next page.

Choose a profiling template for: mac-124553 ) (@l gm?2

Custom Recent Q
OpenGL ES Sudden

Leaks Multicore

Network System Trace

Analysis Termination
‘égiﬁ‘ JIiiIL
System Usage Time Profiler Ul Recorder Zombies
Time Profiler

T
@ Performs low-overhead time-based sampling of processes running on the system's CPUs.

| Open an Existing File... | Cancel | | Choose |

Choose a profiling template for: E mac-124553  |@ll gm?2

Choose Targ  Enter path:

[I/cvmfs/oasis.opensciencegrid.org/gm2/prod/external/art/v1_12_02/d 13.x86_64.(J
mac-1245 | Cancel | [ Go J
Recents 4
Favorites = e
Volumes dev > Beaker.app
A etc ~ = caffeine.app
) home | Calculator.app
Agents L Library »~ (i calendar.app
Daemons B mach_kernel <& Chess.app
Recents F net » | [ICisco >
. Network » € cLion EAP.app
__lopt » |\ Contacts.app
_private > @ Dashboard.app
. sbin » ﬂ Dictionary.app
+ - B | Show Hidden Files [ | Traverse Packages
Arguments
Working Directory

Choose

. Cancel |
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Now you need to fill in the Arguments (1). Type in
the arguments you want to pass to gm2. Let’s run
2000 events through one of the standard fcl files in
gmZ2analyses.

-n 2000 -c muongas_and caloDiagnostic.fcl

You also must fill in the Working Directory (2). If you
want to use your build area, then go to your terminal
window and do

echo $MRB_BUILDDIR

Copy the results to the clipboard with 3 C.Then go
back to the instruments window, click in the Working
Directory box and paste the results with 3V (unlike
in Xcode, environment variables do not seem to
work here).

Press Choose.

Choose a profiling template for: E mac-124553 » [@ gm?2

Choose Target:

mac-124553
Recents
Favorites
Volumes

Agents
Daemons
Recents

>
™~

+

M art

Bl art_ut

B checkClassVersion
Bl check_libs

& config_dumper
gm2

Bl gm2_ut

M lar

Ml lar_ut

B mu2e

- | mu2e_ut

M nova

@ nova_ut

B sam_metadata_dumper

o

1 -n 2000 -c muongas_and_caloDiagnostic.fcl

Name gm2
Size 66.55 KB
Created Wednesday, December 31, 1969 at
6:00:00 PM Central Standard Time
Modified Wednesday, October 8, 2014 at
11:14:29 PM Central Davliaht Time
Owner User cvmfs

| Show Hidden Files | | Traverse Packages

2 /Users/lyon/Development/g-2/profile-sim/build_d13 .x86_64|

| Cancel | [ Choose
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4.2 TIME PROFILER

The time profiler shows you where your program is spending its time.

Choose the Time Profiler from the tem-
plate chooser.

Run the profiler by clicking the red re-
cord button. The example given here
takes about 40 seconds to run.

The result is shown on the right.

The top part shows the CPU usage over
the course of the application.

The bottom shows the detail of the exe-
cution.

You can restrict what is seen in the de-
tail by clicking and dragging over the
timeline.

[CHGNG) Instruments2 ]
® Il | Emac-124553 ) [l gm2 Run 1 of 1 00:00:44 o e NN |
All Cores All Processes / Threads
Instruments b0 ' ' ' ' lobido’ ' ' ' lob30' ' ' lobd0' ' ' ' ' ' lobdo' ' ' ' ' ' lobso’ ' ' ' ' ' 'lodo’ ' ' londo’ '

> @ Time Profiler

[

37332.0ms
10967.0ms
5590.0ms
3044.0ms
2204.0ms
1845.0ms
642.0ms
591.0ms
514.0ms
375.0ms
287.0ms
266.0ms
245.0ms
209.0ms
205.0ms
197.0ms
186.0ms
186.0ms
182.0ms
181.0ms

)
@& Time Profiler

Running Timey

98.0%
28.8%
14.6%
7.9%
5.7%
4.8%
1.6%
1.5%
1.3%
0.9%
0.7%
0.6%
0.6%
0.5%
0.5%
0.5%
0.4%
0.4%
0.4%
0.4%

Self
0.0
1.0 [
10.0
0.0
57.0
4.0 [
13.0
591.0 [
514.0
41.0
62.0
0.0
0.0
0.0
76.0
12.0
2.0
186.0
182.0

1
1
1
1
1
) A
|
|
]
]
|
|
]
]
]
|
]
]
]
|
|
]
]
]

[

= Call Tree Call Tree Q~ Involves Symbol

Symbol Name
¥Main Thread 0x1d09ae
»G4VSensitiveDetector::Hit(G4Step*) |ibC4processes.dylib
» G4EquationOfMotion::RightHandSide(double const*, double*) const |ibC4geometry.dylib
pstart libdyld.dylib
> operator new(unsigned long) libstdc++.6.dylib
»void std::__convert_to_v<long double>(char const*, long double&, std::_los_lostate&, int* const&)
) G4MagErrorStepper::Stepper(double const*, double const*, double, double*, double*) libG4geome
longest_match |ibCore.so
deflate_slow libCore.so
»G4SteppingManager::Stepping() ibG4tracking.dylib
»G4VSolid::ClipPolygonToSimpleLimits(std::vector<CLHEP::Hep3Vector, std::allocator<CLHEP::Hep3V
»0x3ell2e0be826d694
»G4MaglintegratorStepper::ComputeRightHandSide(double const*, double*) libC4geometry.dylib
)-artg4::ArtG4EventAction::EndOfEventAction(G4Event const*) libartg4 geantinit.dylib
»std::string::find(char, unsigned long) const libstdc++.6.dylib
» G4ChordFinder::FindNextChord(G4FieldTrack const&, double, G4FieldTrack&, double&, double, dou
)-artg4::ActionHolderService::preUserTrackingAction(G4Track const*) libartg4 services ActionHoldel
G4PhysicsVector::Interpolation(int) libC4global.dylib
0x7fff91ce8c20 libsystem m.dylib

® = [

Sample Perspective
All Sample Counts

¢ Running Sample Times
Call Tree

(v Separate by Thread

| Invert Call Tree

| Hide Missing Symbols

| Hide System Libraries

| Flatten Recursion

| Top Functions

Call Tree Constraints

[ Count 0 00
[ Time (ms) - o
Data Mining
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The Time Profiler works as follows:

When the executable is run within Instru-
ments, the Stack Trace is sampled every
millisecond.

The Stack Trace is the routine the pro-
gram is running at a given time along
with the traceback (what functions were
called to get to that routine).

The samples are collected and dis-
played in the detail area of Instruments.

The Call Tree shows what functions
were active when the samples were
taken. Functions that appear often are
interpreted to take some fraction of exe-
cution time.

For example, if a function is listed in
1000 samples, then one can interpret
that the cpu is dealing with the function
for 1 second of CPU time (if each sam-
ple is 1 ms).

This sampling yields some limitations. If
a routine is extremely fast, then it may
not show up in the profile. This is ok,
since one is worried about routines

where the CPU is spending a lot of time.

It is often not possible for Instruments to
determine the entire stack trace for
every sample, so you may seen trun-
cated traces.

Let’'s go though the detail in this exam-
ple to learn some things about the g-2
simulation.
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Call Tree Qv Involves Symbol ® B [E

Symbol Name Heaviest Stack Trace =5
¥Main Thread Ox1d09ae
P G4VSensitiveDetector::Hit(G4Step*) libG4processes.dylib @

Time Profiler = Call Tree
(-]

Running Timewy Self
37332.0ms 98.0% 0.0

10967.0ms 28.8%| 1.0 &

14 37332.0 Main Thread 0x1d09ae
13 10967.0 G4VSensitiveDetector::Hit(G4Step*)

5590.0ms 14.6% 10.0 » G4EquationOfMotion::RightHandSide(double const*, double*) const |ibC4geometry.dy!
3044.0ms 7.9% 0.0 pstart libdyld.dylib 12 10943.0 gm2ringsim::StrawSD::ProcessHits(G4Step...
2204.0ms 5.7% 57.0 b operator new(unsigned long) libstdc++.6.dylib Il 10938.0 gm2ringsim::StrawHit::StrawHit(G4Step*)
1845.0ms 4.8% 4.0 pvoid std::__convert_to_v<long double>(char const*, long double&, std::_los_lostate&, int 10 10760.0 gm2geom::StrawTrackerGeometry::Straw...
642.0ms 1.6% 13.0 »G4MagErrorStepper::Stepper(double const*, double const*, double, double*, double*) | 9 4632.0 gm2geom::VacGeometry::VacGeometry(std...
591.0ms  1.5% 591.0 Iongest_match’ libCore.so 8 2436.0 std::vector<double, std::allocator<double...
914.0ms  1.3% >14.0 deﬂate_s-low libCore.so ) , , , 7 2425.0 bool fhicl::ParameterSet::get_if_present<st...
375.0ms 0.9% 41.0 b G4SteppingManager::Stepping() libG4tracking.dylib - S el A Ao e o b
287.0ms 0.7% 62.0 »G4VSolid::ClipPolygonToSimpleLimits(std::vector<CLHEP::Hep3Vector, std::allocator<CL ’ " e e
266.0ms  0.6% 0.0 »0x3el12e0be826d694 5 2276.0 void fhicl::detail::decode<double>(boost::...
245.0ms 0.6% 0.0 » G4MaglntegratorStepper::ComputeRightHandSide(double const*, double*) libG4geome 4 2133.0 fhicl::detail::decode(boost::any const&, lon...
209.0ms 0.5% 0.0 bartg4::ArtG4EventAction::EndOfEventAction(G4Event const*) libartg4 geantinit.dylib 3 1876.0 fhicl::parse_value_string(std::string constg&,...
205.0ms 0.5% 76.0 bstd::string::find(char, unsigned long) const |ibstdc++.6.dylib 2 630.0 fhicl::value_parser<__gnu_cxx::__normal_ite...
197.0ms 0.5% 12.0 »G4ChordFinder::FindNextChord(G4FieldTrack const&, double, G4FieldTrack&, double&, ¢ 1 221.0 szone_free_definite_size
186.0ms 0.4% 2.0 b-artg4::ActionHolderService::preUserTrackingAction(G4Track const*) libartg4 services A g 47.0 tiny_free_list_add_ptr
186.0ms 0.4% 186.0 G4PhysicsVector::Interpolation(int) libC4global.dylib
182.0ms 0.4% 182.0 0x7fff91ce8c20 libsystem m.dylib

181.0ms 0.4% 96.0

b __cxxabivl::__vmi_class_type_info::__do_dyncast(long, __cxxabivl::_ class_type_info::_ s

In this display, the Running Time shows
the total time the CPU is in that routine
or a function the listed routine calls.

Self shows how many samples that
were taken where the routine listed was
at the bottom of the stack (the routine
the CPU was actually running).

The symbols are not a stack trace. It is
a list of routines found in the stack

traces. If you select one, on the right
side you can see the stack trace that ap-
peared in the most samples. The bottom
of the trace is what the CPU was run-
ning when the sample was taken. Mov-
ing up the trace, you see the routines
that were called to lead to that function.
This particular trace is truncated.

Let’s look at the detail window. One
thing that stands out is that

G4VSensitiveDetector: :Hit appears

in ~30% of the samples. This doesn’t
mean that the CPU was running that par-
ticular routine 30% of the time. Instead it
means that in 30% of the samples, the
routine at the bottom of the stack trace
(the one what was running) was called
by this particular routine (with perhaps
many routines in between). We will dive
into this situation on the next page.
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@& Time Profiler
Running Timey
37334.0ms 98.0%

10967.0ms 28.8%
10943.0ms 28.7%

10760.0ms 28.2%
4632.0ms 12.1%
3076.0ms 8.0%
1327.0ms 3.4%
763.0ms 2.0%
481.0ms 1.2%
243.0ms 0.6%
92.0ms 0.2%
72.0ms 0.1%
21.0ms 0.0%
12.0ms 0.0%
7.0ms 0.0%
4.0ms 0.0%
3.0ms 0.0%
2.0ms 0.0%
2.0ms 0.0%

0.0
1.0

1.0

12.0
15.0
3.0
2.0
1.0
4.0
1.0
0.0
0.0
11.0
12.0
2.0
0.0
3.0
2.0
0.0

= Call Tree Call Tree Q- Involves Symbol

Symbol Name
V¥Main Thread 0x1d09ae
Vv G4VSensitiveDetector::Hit(G4Step*) libC4processes.dylib
wgm2ringsim::StrawSD::ProcessHits(G4Step*, G4TouchableHistory*) libom2ringsim_str
v¥gm2ringsim::StrawHit::StrawHit(G4Step*) libgm2ringsim_strawtracker.dylib @
vgm2geom::StrawTrackerGeometry::StrawTrackerGeometry(std::string const&) |ibg

P gm2geom::VacGeometry::VacGeometry(std::string const&) libgm2geom_vac.dyli
pstd::vector<double, std::allocator<double> > fhicl::ParameterSet::get<std::vecto
bdouble fhicl::ParameterSet::get<double>(std::string const&) const libgm2geom_
bstd::vector<int, std::allocator<int> > fhicl::ParameterSet::get<std::vector<int, st
P gm2geom::GeometryBase::GeometryBase(std::string const&) libgm2geom_ strawl
b bool fhicl::ParameterSet::get<bool>(std::string const&) const libgm2geom_infle
»gm2geom::VacGeometry::~VacGeometry() libgm2geom strawtracker.dylib
p-int fhicl::ParameterSet::get<int>(std::string const&) const libgm2geom_strawtra
pszone_free_definite_size libsysterm_malloc.dylib

std::string::_Rep::_M_dispose(std::allocator<char> const&) (.part.5) libgm2geor
»free libsystem_malloc.dylib
P <Unknown Address>

std::string::_Rep::_M_dispose(std::allocator<char> const&) (.part.5) libgm2georr

DYLD-STUBS$ $std::basic_string<char, std::char_traits<char>, std::allocator<char:
p-operator new(unsigned long) libstdc++.6.dylib

Opening the exposure triangles, you see the StrawTrackerGeometry constructor.
more routines. These are the routines Let’s look at this code to see what is go-
that are called by the routine at the ing on. Double clicking on the high-
higher level (outdented). Again, this is lighted line gives the source code.

not an explicit stack trace. It is a list of

routines at the next level of depth in the

See next page.

stack trace with their timing information.

What we see is that 30% of the execu-
tion time is in the StrawHit constructor.
And that is because the constructor calls

© & [a

Heaviest Stack Trace

14 37334.0 Main Thread 0x1d09ae
13 10967.0 G4VSensitiveDetector::Hit(G4Step*)

12 10943.0 gm2ringsim::StrawSD::ProcessHits(G4Step...

11 10938.0 gm2ringsim::StrawHit::StrawHit(G4Step*)

10 10760.0 gm2geom::StrawTrackerGeometry::Straw...
9 4632.0 gm2geom::VacGeometry::VacGeometry(std...
8 2436.0 std::vector<double, std::allocator<double...

221.0 szone_free_definite_size

O = N W H»h U1 OO N

47.0 tiny_free_list_add_ptr

2425.0 bool fhicl::ParameterSet::get_if_present<st...
2292.0 bool fhicl::ParameterSet::get_one_<std::ve...
2276.0 void fhicl::detail::decode<double>(boost::...
2133.0 fhicl::detail::decode(boost::any const&, lon...
1876.0 fhicl::parse_value_string(std::string const&,...

630.0 fhicl::value_parser<__gnu_cxx::__normal_ite...
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@® Time Profiler

98
99
100
101
102
103

104
105

106
107
108
109
110
111
112
113
114
115
116

void gm2ringsim::StrawHit::Draw(){

=(
StrawHit.cc
(worldPosition);

}

G4VPhysicalVolume xmodule_vol = history->GetVolume(depth-1);

if (module_vol){

G4RotationMatrix rotInv = history->GetTransform(depth-1).NetRotation().

inverse();

//position in detector coordinates

module_position = history->GetTransform(depth-1).TransformPoint
(worldPosition);

}

gm2geom: : StrawTrackerGeometry g;

scallop_position.set(module_position.x() +
g.distShift[wire.getModule()],
module_position.y() + g.strawModulelLocation[wire.getModule()],
module_position.z());

Here we see that for every tracker hit,
the StrawTrackerGeometry is retrieved.
And that appears to be an expensive op-
eration, taking up nearly all of the CPU
time for this routine.

A good solution would be to cache the
geometry somewhere. Doing so could
potentially save a large amount of execu-
tion time.

Call Tre gm2ringsim::StrawHit::Strawl Q- Involves Symbol ©® s [=

Annotations
v Source
98.48% gm2geom::StrawTrackerGeometry g;
0.95%
0.19% WirelD wire = gm2strawtracker::wirelDfromStrin...
0.16% volumeUID = pvs->idGivenPhysicalVolume( step...
0.06% g.distShift[wire.getModule()],

0.05%
0.02%
. 98.5% 0.02% // Next get the rest of the line (parses to the next \n)
0.01%
0.1% 0.01%

0.01% #include "gm2geom/strawtracker/StrawTracker...
0.01% local_momentum = world_momentum.transform...
0.01% std::getline(thing, parseString, '-");

0.01%
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4.3 MEMORY ALLOCATION AND LEAK PROFILING

You can watch memory usage over time.

You can start by choosing the Alloca-
fions and Leak profilers from the begin-
ning template screen. Or, if you are al-
ready profiling (e.g. with the Time Pro-
filer), delete the current instrument (/n-
strument > Delete).

Then press the + sign near the top of
the window. Choose the Allocations and
Leak profilers.

The Allocations profiler works by instru-
menting all calls to allocate and free
memory. Doing so adds a significant
amount of time to the execution of the
program. Following our example, let’s
change the arguments to do 200 events

instead of 2000. You can do so by choos-

ing and then editing the target.

In the Allocations profiler, you want to
watch for a consistent rise in memory
over time. Such a rise could indicate mis-
takes in memory management.

The Leak profiler indicates memory that
is no longer accessible. This happens if
memory is allocated and referred to by a
pointer, but the pointer goes out of
scope or is deleted. That allocated mem-
ory can no longer be accessed and is a
memory leak.
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® 006

il E mac-124553 ) [l gm2

Instruments

AN

2 % Allocations
; o~

(2 % Leaks

I
I
I
I
I
¥

[uw

Wi Allocations

Graph
v

Category

All Heap & Anonymous VM
All Heap Allocations
All Anonymous VM
Malloc 80 Bytes
Malloc 43.00 KB
Malloc 224 Bytes
Malloc 112 Bytes
Malloc 336 Bytes
Malloc 48 Bytes
Malloc 1.50 KB
Malloc 64 Bytes
G4LogicalBorderSurface
Malloc 96 Bytes
Malloc 32 Bytes
Malloc 16 Bytes
TDataType

Malloc 256.00 KB
TList
TObjLink

Malloc 160.00 KB
TDataMember
Cint::G__Typedefinfo
TNamed
TRealData

|
FH statistics

Instruments3

Run 1 of 1 00:02:22

Allocation Summary

Persistent Bytesy # Persistent

44.72 MB
44.72 MB

4.00 KB
29.92 MB

3.78 MB

1.78 MB

1.39 MB

1.14 MB
821.34 KB
733.50 KB
569.00 KB
486.00 KB
433.50 KB
425.75 KB
380.30 KB
299.25 KB
256.00 KB
211.02 KB
198.31 KB
160.00 KB
149.84 KB
148.62 KB
104.69 KB
100.47 KB

521,316
521,315
1
392,108
90
8,328
13,017
3,563
17,522
489
9,104
10,368
4,624
13,624
24,339
2,394

1

2,701
6,346

1

685
2,378
429
1,286

# Transient  Total Bytes
33,083,563 2.05GB
33,083,562 2.05GB

1 12.00 KB
2,565,545 225.65 MB
0 3.78 MB

6,388 3.14 MB
15,379 3.03 MB
353,956 114.56 MB
12,924,834 592.45 MB
734 1.79 MB
1,865,887 114.44 MB
0 486.00 KB
2,121,524 194.65 MB
7,963,985 243.46 MB
2,026,727 31.30 MB
0 299.25 KB

1 512.00 KB

1,481 326.72 KB
11,004 542.19 KB

2 480.00 KB

0 149.84 KB

0 148.62 KB

240 140.31 KB

0 100.47 KB

Qv Instrument Detail

# Total

33,604,879
33,604,877
2
2,957,653
90

14,716
28,396
357,519
12,942,356
1,223
1,874,991
10,368
2,126,148
7,977,609
2,051,066
2,394

2

4,182
17,350

3

685

2,378

669

1,286

Transient/Total Bytes

+++
+++

© & [=

Generation Analysis

Mark Generation

Allocation Lifespan

_ All Allocations
(® Created & Persistent
_ Created & Destroyed

Allocation Type
@ All Heap & Anonymous VM
_ All Heap Allocations
All VM Regions

Call Tree
Separate by Category
Separate by Thread
Invert Call Tree
Hide Missing Symbols
Hide System Libraries

Flatten Recursion

Call Tree Constraints

Count 0 00
Bytes -0 %

Dhoto AAianiame

+ = | wd L1

Lo6i0d" ' 11600 1 1166:20 " 100130 " 1110640 " 166/50" 1 101000 1 I6dig ! ! 101420 11010 " ! lokidd 1 101080 !t I6aidg ' l02!H 162,
I

This display shows a list of all memory

allocations. For some, Instruments can

figure out the object type. It can’t for oth-
ers and they are shown as Malloc.

Memory peaks at about 85 MB and then
drops at the end to about 45 MB.

Though it is not easy, one can trace
when memory is created and destroyed

by the program.

Two periods of leaks are seen. Select

the Leak profiler to learn more about the

leaks.

42



